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A DIGITAL MUSIC PLAYER FOR
THE SOPHISTICATED MUSIC LOVER

Fidelia is an elegant and powerful music player created exclusively for OS X.
Anyone with a passion for music knows the value of high-quality hardware,
whether it's a perfectly calibrated power amp or world-class pair of speakers.
Shouldn't your software live up to the same high standards?

Fidelia lets discerning OS X users truly optimize their home listening experience,
preserving maximum sonic fidelity across multiple file formats and delivering
uncluttered utility with an elegant user interface. Powered by Audiofile Engineering's
Fidelia Audio System, it gives you the tools and the freedom to savor the sounds
that you love, all the way from your hard drive to your eardrums.
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Welcome to Fidelia

NEED HELP GETTING STARTED?

STAY IN TOUCH

I | | I I | | Subscribe to our newsletter to receive the

latest Fidelia news, tips and more.

’ @weareaudiofile

Show this window when Fidelia opens

WELCOME TO FIDELIA

WHEN YOU FIRST LAUNCH FIDELIA, A WELCOME SCREEN APPEARS

From this welcome screen you can view relevant screencasts, open the User Guide and subscribe to the Audiofile newsletter.
Click “OK?” to hide this window and begin your Fidelia experience. To return to this window, choose Help > Welcome to Fidelia.

VERSIONS OF FIDELIA PURCHASED FROM THE MAC APP STORE WILL LAUNCH IMMEDIATELY INTO ITS FULL WORKING MODE.
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LICENSES PANE

Fidelia’s Licenses pane allows you to manage all of your Fidelia-related
licenses, including those for Fidelia Advanced.

Licenses

Fidelia
1|I|l|| Manage Key ~

To view the Licenses pane, go to Fidelia > Licenses in the application
menu bar.

To add a license, simply click “Add Key” next to the relevant product.
A popover will appear, allowing you to add your user name and
license key.

Note: Only users who purchased a Fidelia Basic license prior to the
release of version 1.6 will have the option to add a license key for
Fidelia Advanced.

In copies of Fidelia purchased from the App Store, the Licenses
pane does not appear. Users who purchased Fidelia prior to 1.6

will have the ability to restore the Advanced in-app purchase
from Fidelia > Restore Purchases... FHX is now CanOpener™
and is available to everyone
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IN TRIAL
8 Days Left

LICENSED

UNLICENSED

TRIAL MODE

Fidelia is unlicensed but will remain fully-featured during its
15 day trial period.

LICENSED MODE

Fidelia is running in its full-featured mode and licensed to you.

UNLICENSED MODE

Fidelia is unlicensed. Either your trial mode ended or your

license has become corrupt or invalid. Contact our support team.

support@audiofile-engineering.com.
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IN TRIAL
8 Days Left

TRIAL PERIOD

FIDELIA AND ITS FEATURE UPGRADES RUN IN TRIAL MODE FOR 15 DAYS

During the trial period, the application functions fully.

The App Store does not support trial versions or modes
for apps and/or feature upgrades.
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Fidelia
The Alarmists ¢ Flutter & Fly
s

( AUGraphicEQ v (O BC FregAnalyst 2 (Stereo. ¥

TRANSPORT

THE TRANSPORT FEATURES PLAYBACK, TRACK NAVIGATION, AND VOLUME CONTROL

The volume knob is controlled by moving the mouse along a vertical or horizontal axis (specified in Preferences > General).
The “Dim” button lowers the audio by 20dB.
The “Mute” button mutes the audio.

The buttons to the far left are Shuffle and Repeat. Click Repeat once to repeat the song, and click it twice to repeat the playlist.
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WAVEFORM, METER & SONG INFO

The section in the upper left portion of the Player features the song waveform, meter, and song info (Artist name and Song name).

It also features the elapsed or remaining time of a track. Click on the elapsed time to toggle between counting up or down.
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FILE DETAILS

The file details section is in the upper right corner of the Player. It features track length, file type, and file size information.

EFFECTS

The bottom portion of the Player is the effect rack. You can host three Audio Units plug-ins in the Player.
To view the effect interface, click on the effect name.
To add/remove an effect click on the triangle and navigate the contextual menu.

To disable an effect click on the power button to the left of the effect.
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[1] Weekend Mix
[B Mix for Nikki
[1] Ambient

[1] Classical Music

ITUNES

n Library

m 90's Music
[J 90's Throwback
m Classical

[R pub

m Electronic

m Metal

m Psychedelia

Library

Name

Xtal

Tha

Pulsewidth

Ageispolis

|

Green Calx

Heliosphan

We are the music makers
Schottkey 7th Path
Ptolemy

Hedphelum

Delphium

Actium

KC Bound/So That's That
Unicorn Uniform

Rck N Roll Plankton Unite!
Bubble

Yellow Sun

THE LIBRARY

TO ACCESS THE LIBRARY, SELECT WINDOW > LIBRARY

Album
Selected Ambient Works 85-92

Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Gary Victorsen's

Gary Victorsen's

Gary Victorsen's

Gary Victorsen's

Gary Victorsen's

36 songs, 2:28:31 total time, 365.7 MB

Artist

Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Alpha Consumer
Alpha Consumer
Alpha Consumer
Alpha Consumer
Alpha Consumer
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[—,_F] Weekend Mix
[B Mix for Nikki
@ Ambient

@ Classical Music

ITUNES
Jd Library
m 90's Music
[J 90's Throwback
m Classical

[R pub

m Electronic

m Metal

Dz Psychedelia

Library

Name

Xtal

Tha

Pulsewidth

Ageispolis

|

Green Calx

Heliosphan

We are the music makers
Schottkey 7th Path
Ptolemy

Hedphelum

Delphium

Actium

KC Bound/So That's That
Unicorn Uniform

Rck N Rell Plankton Unite!
Bubble

Yellow Sun

Album
Selected Ambient Works 85-92

Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Gary Victorsen's

Gary Victorsen's

Gary Victorsen's

Gary Victorsen's

Gary Victorsen's

36 songs, 2:28:31 total time, 365.7 MB

PLAYLIST SECTION

The Playlist section is on the left side of the Library window. It features the Fidelia library and
iTunes library. Notice that the iTunes library and subsequent playlists contain a lock symbol
which means that they are not editable within Fidelia. Of course, the Fidelia library and Fidelia
playlists are completely configurable.

Artist

Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Alpha Consumer
Alpha Consumer
Alpha Consumer
Alpha Consumer
Alpha Consumer

The bottom of the Playlist section contains three buttons. In order from left to right they are
create playlist, shuffle, and repeat. The repeat button has three modes - off, repeat all, and

repeat one.
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FIDELIA el

Xtal
[H weekend Mix Tha
[R Mix for Nikki Pulsewidth
[ Ambient Sgeispots
[h ciassical Music !
Green Calx
ITUNES_ Heliosphan
ﬂ Library We are the music makers
[& 90's Music Schottkey 7th Path
[J 90's Throwback Ptolemy
m Classical Hedphelum
[A pub Delphium
m Electronic Actium
[R Metal KC Bound/So That's That

l—_jl e Unicorn Uniform

Rck N Rell Plankton Unite!
Bubble
Yellow Sun

SONG SECTION

Library

Album
Selected Ambient Works 85-92

Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Selected Ambient Works 85-92
Gary Victorsen's

Gary Victorsen's

Gary Victorsen's

Gary Victorsen's

Gary Victorsen's

36 songs, 2:28:31 total time, 365.7 MB

Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Aphex Twin
Alpha Consumer
Alpha Consumer
Alpha Consumer
Alpha Consumer
Alpha Consumer

THE SONG SECTION DISPLAYS ALL THE SONGS IN THE SELECTED LIBRARY/PLAYLIST.

Columns can be hidden or revealed using the View menu. Choose as many or as few

columns from the list as you wish.

Once viewable, a column can also be reordered. Simply click the column name and drag

it horizontally to its desired position.

The search field in the upper right corner searches artist, album, composer and song name.
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| N Preferences
# % 0O 6 & [
General ‘ Commands Format Output CanOpener Advanced
Metering Point: = Pre Effects | T

Volume Knob: Vertical [T

Audio device is exclusive to Fidelia

Load audio file into physical memory

Access iTunes Library
Dither

Enabled
Type: Goodhertz

Depth: 16-bit

Amount: Optimal

ofofofo

Noise Shaping: = Optimal

Auto Blanking

GENERAL

METERING POINT

Determines the metering point used to measure level displayed on the
meter in the Player. Use the drop-down menu to select a Pre Effects,
Post Effects, or Post Volume metering point.

VOLUME KNOB
Determines which mouse axis controls the Volume Knob on the Player.
Use the drop-down menu to select Horizontal or Vertical.

The “Audio device is exclusive to Fidelia” checkbox toggles what is
commonly known as "hog mode". Enabling this makes Fidelia the only
application that can access the selected audio device.

The “Load audio file into physical memory” checkbox will load the audio
file into RAM, rather than stream it from your hard-disk. This is most useful
when playing files stored on a network drive or server.

The “Access iTunes Library” checkbox enables or disables iTunes Library
syncing. When enabled, all music files currently in iTunes will appear in
Fidelia’s Library window.

Note: Previous versions of Fidelia utilized iTunes’ Library.xml file for iTunes
Library access. This is no longer necessary if you have iTunes 11+ installed.

DITHER

Select the dither type, bit-depth, dither amount, and noise shaping.
When the Dither checkbox is enabled the output is dithered on-the-fly
to the selected bit range using the selected dithering processor.

The Auto Blanking checkbox will mute the dither noise when playback
is silent for .7 seconds.
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[ N Preferences

O 6

Format Output

o 3

General Commands

[+

CanOpener Advanced

Presets ‘

Description
» Fidelia Menu
» File Menu
» Edit Menu
> View Menu
¥ Controls Menu
Play
Next
Previous
Shuffle
» Repeat
Dim
Mute
Disable Effects
» Window Menu
» Help Menu

(SR HCJSJ QR JJ QN Q<< J< H<J§Y

Q

Shortcut

[space]
¥
B

@©
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COMMANDS

You can easily assign Keyboard Commands to menu commands.
Access the Keyboard Commands panel by selecting Fidelia >
Preferences > Commands.

BROWSE COMMANDS
You can browse commands by expanding the categories and
scrolling through the list.

SEARCH
Or you can use the search field at the top right of the panel to
quickly find any existing Commands.
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O Preferences
#  # 0 ol & I
General Commands Format Output CanOpener Advanced

Enter the key combination you would like to use for “New
Playlist”

&N

Clear Cancel OK

» Window Menu
»Help Menu

I Show in Finder #*R
Create AIFF Version
Rescan
» Edit Menu
»View Menu
» Controls Menu

@©
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ASSIGN COMMANDS

Double-click a command in the list and a sheet is displayed
prompting you to assign a keyboard shortcut for that item.

Type a Keyboard Shortcut and click the "OK" button. You will

be warned if the shortcut is already in use. To remove a shortcut,
click "Clear."
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Preferences

& 0O

General Commands ‘ Format

e I

CanOpener Advanced

Presets n

Save...
Restore Defaults...

Import...
Export...

(I J B J R Q< J< Q<]

wew raynscvirom Selection
Close Window
Add to Library...
Get Info
Show in Finder
Create AIFF Version
Rescan
» Edit Menu
»View Menu
» Controls Menu
»Window Menu
»Help Menu

Q

Shortcut

0N
#’W
#0
38l
#R

@©
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SAVE, EXPORT
& LOAD PRESETS

SAVE

You can save Keyboard Commands as presets. To save your
Keyboard Commands, select "Save..." from the drop-down menu
at the upper left of the panel. Saved Commands are automatically
added to the drop-down menu.

RESTORE DEFAULTS...
Restores all default commands, removing any user-created
commands from Fidelia’s Keyboard Commands library.

IMPORT
If you wish to import an existing keyboard command, select
“Import...” from the drop-down menu.

EXPORT
If you wish to specify the save location, select "Export..." from the
drop-down menu.
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[ N ) Preferences

J#" a8 0 B a r

General Commands ‘ Format ‘ Output CanOpener Advanced

Preferred Audio File Format

Format: FLAC | <

Sample Rate:  44.1 kHz [T

Bit Range: 16-bit | <

Apply Dither:

Compression:

Less

Create preferred version when adding to Library

Audiofile

FORMAT

FORMAT
Choose the preferred audio file format from the following options:
AlIFF, Wave, CAF, AAC, Apple Lossless, Ogg Vorbis, and FLAC.

SAMPLE RATE

Choose the sample rate of the preferred audio file format from
the following options: 44.1kHz, 48kHz, 88.2kHz, 96kHz, 176.4kHz,
and 192kHz.

BIT RANGE
Choose the bit range of the preferred audio file format from the

following options: 16-bit, 24-bit, and 32-bit.

QUALITY
The Quality slider activates if Ogg Vorbis is the preferred format.
The Compression slider activates if FLAC is the preferred format.

CREATE PREFERRED VERSION WHEN ADDING TO LIBRARY

Create preferred version when adding to Library Toggle this
checkbox for Fidelia to create the preferred audio file when a file
is added to the Fidelia Library. The converted file is created in the
same directory as the original file and does not overwrite the
original file. Note that you can perform this action on an individual
basis using the "Create File Type Version" command from the File
menu (or with a keyboard shortcut associated to the command).
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OUTPUT

AUDIO OUTPUT
Select Fidelia's final audio destination from the list of available

system outputs. If the audio output you desire isn't in this list,

e Preferences
66 H k2] H
J o* 99 0 B & = select the “Configure...” button to launch Audio MIDI Setup.
General Commands Format ‘ Output | CanOpener Advanced

Use the channel selection view to specify the output channels
to use for your device.

Audio output: = Built-in Output | T

Configure...

Channel
Channel 1
Channel 2
Channel 3
Channel 4
Channel 5
Channel 6

DEVICE SAMPLE RATE

Using this drop-down menu you can choose to set a fixed sample
rate of 44.1 kHz, 48.0 kHz, 88.2 kHz, 96.0 kHz, or have the device
change to match the sample rate of the song.

Don’t Change

Device Sample Rate:

Goodhertz

Converter:

CONVERTER

Select your desired output converter from the choices available.
Fidelia offers three resampler options: Goodhertz, iZotope,

or Apple AUConverter.

Filter Type: = Minimum Phase | T

Quality:

Faster

QUALITY

Adjust the Quality slider to alter the quality of the output conversion
process. Choose between getting Faster results (less CPU intensive)
versus getting Better results (more CPU intensive) that take longer
to complete.
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General Commands Format Output CanOpener Advanced

Enable CanOpener Headphone Processor

Crossfeed

USING CANOPENER"

CANOPENER WAS DESIGNED TO ADDRESS A NUMBER OF ISSUES
OFTEN ASSOCIATED WITH LISTENING TO MUSIC ON HEADPHONES

0°
Speaker Angle:

Type: Most Realistic [T

0%
Amount: ;

Prevent Clipping

Equalization

CanOpener was designed by mastering engineer Devin Kerr and is
a result of extensive research and listening tests. By incorporating
several broad spatial characteristics of an ideal loudspeaker
playback setup, CanOpener creates a more spacious, natural
soundstage over headphones—enabling an exceptional listening
experience that will truly inspire and engage. With user controls
that are simple and effective, the algorithm can be fine tuned to
your personal music library, listening preferences, and hardware.

Treble: 5000 [T Hz
-6dB

Bass: 250 [T Hz

-6dB

% Prevent Clipping

Monitoring

Balance:

Mono: Phase: u Out

Swap Channels:
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WHAT’S WRONG WITH HEADPHONES

In theory: nothing; in the real world: a lot. The main “problem”
with headphones is that most music is created (recorded, mixed,
mastered) on speakers, with tools that were primarily designed
for loudspeaker playback. Hence, a type of auditory translation
error occurs when music is instead played back on headphones.
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CROSSFEED

The biggest difference between headphone and loudspeaker i et 75°
listening is crossfeed. In the case of stereo loudspeaker listening, ’

a sound fed from the right loudspeaker not only reaches the I .
right ear of the listener, but a portion of the sound also reaches GIEIE |Q

the left, far ear as well. ) Prevent Clipping

Type: Most Realistic [T

The inverse is true of the left loudspeaker: sounds emitted reach the
left ear first, while a portion also reaches the right ear. Thus, sounds
presented over loudspeakers are partly crossfed to each opposing
ear of the listener.

Comparing to a headphone environment: sounds fed from the
left channel of a pair of headphones only reach the left ear, and
likewise, sounds fed from the right channel only reach the right
ear. The subjective effects of these differences between
headphone and loudspeaker listening are extremely significant.
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EQUALIZATION

CanOpener utilizes a unique, dynamic-range optimized equalization
section to maintain the highest possible digital resolution at any
setting. So, you’ll never need to worry about digital clipping,
distortion, or loss of headroom when using CanOpener.

Equalization

Treble: 5000 2 Hz

-6dB +6dB

Bass: 250 [T Hz

-6dB +6dB

7 Prevent Clipping

Audiofile
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MONITORING

The CanOpener monitoring section offers several key monitoring
facilities that are typically reserved for high-end monitor controllers
or mastering consoles.

Mono enables a user to monitor the mono summation of the left and
right channels. This control is post “Balance” and “Phase” processing.
Phase allows inversion of the right channel polarity. Swap Channels
swaps the left and right channels such that left becomes right, and
right becomes left. Balance allows you to adjust balance of the left
and right channels.

Monitoring

Left Right
Balance:

Mono: Phase: u Out

Swap Channels:
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® @ Preferences

# ¥ 0O B & @ F

General Commands Format Output CanOpener Advanced

Dither Settings

Shape: High [T Auto Blanking
Minimize Peaks

Amount: Normal | <)
Silence Harmonics

Bits:

iZotope Resampler Settings

Presets

Filter steepness:

Cutoff scaling:

Pre-ringing:

Note: Advanced is a paid feature add-on.

Audiofile

FIDELIA ADVANCED

The Advanced preferences tab is only available to users who
purchased Fidelia prior to 1.6 and who already own a license
for Fidelia Advanced

These preferences are specific to the iZotope Resampler and Dither.

FILTER STEEPNESS

The critical step in any resampling implementation is the lowpass
filter used to discard frequencies which cannot be represented or
are undesirable in the target format. The steepness parameter
controls the steepness of the transition band of the lowpass filter.
Higher steepness will reject unwanted frequencies but cause
more ringing in the time-domain and a higher CPU load.

CUTOFF SCALING

The cutoff frequency of the resampler's lowpass filter can be scaled
back from the Nyquist frequency. The cutoff frequency is computed
by multiplying the Nyquist frequency by the value of the cutoff
scaling parameter. Larger values of cutoff scaling offer a flatter
pass-band, while smaller values offer better aliasing suppression.
Typical values are close to 1.0.

PRERINGING

All lowpass filters are characterized by the amount of ringing they
introduce into their output. The steeper the filter, the greater the
amount of ringing.
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MORE ABOUT
PRERINGING

There are two general types of ringing: pre-ringing and post-ringing. Preringing will smear transients
earlier in time, while postringing will smear transients later in time. This control allows users to select
pre-ringing, post-ringing, or anywhere in between. A value of 1.0 produces a linear phase filter with
equal pre- and post-ringing. A value of 0.0 produces a minimum phase filter which offers no
pre-ringing but has non-linear phase distortion which can be objectionable. Setting intermediate
values allows a continuous tradeoff between pre-ringing and post-ringing and allows users to
linearize phase in the pass-band as much as possible.
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SUPPORT PANE

SCREENCASTS

Displays a current list of all video tutorials available for Fidelia.
Select a screencast in the left column and it will load to the right.
Select "Notify me of new tutorials" if you wish to be notified when
new screencasts are posted. There are currently no screencasts
available for Fidelia.

o0 Fidelia Support

0 & O

Screencasts Roadmap ’ Update Requests

Get Involved!
Help us to create better software for you by assisting in prioritizing upcoming features:

: ROADMAP
' ‘}»1 Displays a list of upcoming features.

Feature My Rating
Smart Playlists * % Kk X
Crossfading controls in Playlists 1 8. 0. 0. 8.1
Anticlick on stop ' 2. 0. 0. 0.1

UPDATES

This pane configures how and when Fidelia checks for updates.
To check for updates every time you launch Fidelia, select

"At startup." To check Daily, Weekly, or Monthly, select the check
box next to the pop-up list and select option. To check for updates
immediately, click the "Check Now" button.

Submit Feature...

REQUESTS

This pane allows you to submit and track support requests. The
Help Desk will automatically populate contact information using
the "Me" entry from Address Book. You can change this information
at any time.

Note: Your email address is used to track requests. Please make
sure it is correct.
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Ode To Love
A
Austin Peralta

O
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FIDELIA REMOTE
FOR IOS

Fidelia Remote for iOS turns your iPhone or iPod touch
into a full-featured remote control for the Fidelia music
player. Browse your Fidelia library and playlists, adjust
playback volume and navigate between or within tracks
from as far away as your wireless network allows.

# Download on the
S App Store


https://itunes.apple.com/us/app/fidelia-remote/id408043917?mt=8
https://itunes.apple.com/us/app/fidelia-remote/id408043917?mt=8
https://itunes.apple.com/us/app/fidelia-remote/id408043917?mt=8
https://itunes.apple.com/us/app/fidelia-remote/id408043917?mt=8

CREDITS
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SPECIAL THANKS

iZotope 64-bit SRC™, MBIT+" dither, Consumer Restoration & SonicFit"
IZOTOPE.COM

CanOpener™ and Goodhertz SRC and Dither by Devin Kerr
GOODHERTZ.CO

Musepack by the Musepack Development Team
MUSEPACK.NET

Monkey’s Audio by Matt Ashland
MONKEYSAUDIO.COM

WavPack by David Bryant
WAVPACK.COM

Ogg Vorbis & FLAC by the Xiph.org Foundation
XIPH.ORG

Sparkle by Andy Matuschak
SPARKLE.ANDYMATUSCHAK.ORG

The Intrepid Travis "T-Dawg" Burgess, Corey Walo,
Avi Agrawal, Alex Henderson, Chris Smalley,

Dan Comerchero, Josh Lynch, Jason Hinze,

David Hearst, Rob Crane, Devin Kerr, Chris Liscio,
Jeremy Todd, Mark Ethier, Alex Westner, Scott Simon,
Craig Hanson, Alexander Ljung, Henrik Lenberg,
Brian & Martina McConnon, Marcus Ryle,

Jim D’Addario, Taylor Carrigan, Chris Masterson,
James Cigler, Ryan Hisey, Dave Gan, Josh Johnson,
Patrick Flanagan, Jeff Krumm, Craig Linssen,
Michael Wong, Stephen Chick, Bill Stewart.





